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Introduction 

Purpose 
The objective of the release notes is to describe new and revised functionality in this version of 
GRAMS Envision, as well as platform combinations used in formal testing, fixed defects and 
known defects. 

Inventory of Materials 
The GRAMS Envision 2.1 installation kit includes the following items: 

• GRAMS Envision 2.1 setup executable 

• GRAMS Converters 9.2.4 installation package 

• Revised user manuals: 

• GRAMS Envision Installation Guide 

• GRAMS Envision User Guide 

• GRAMS Envision Welcome Guide 

• Release Notes 
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Testing Information 
The following platform combinations were used in testing. 

Primary Testing Platform 

Platform Operating System or 
Application 

Version Role 
(Configuration) 

Intel Core i5 
3.1 GHz 
4 GB RAM 

Microsoft Windows 7  

Internet Explorer 

Enterprise Edition SP2 x64 

8.0 

Workstation 

Secondary Testing Platform 

Platform Operating System or 
Application 

Version Role 
(Configuration) 

Intel Core 2 
3.0 GHz 
4 GB RAM 

Microsoft Windows Server 
2008 

Thermo Web Access 

Enterprise Edition R2 x64 
 

4.0.1 SP5 

Application Server 

Intel Core 2 
3.0 GHz 
4 GB RAM 

Microsoft Windows 7  

Internet Explorer 

Standard Edition SP2 x32 

7.0 

Web Access Client 

Tertiary Testing Platform 

Platform Operating System or 
Application 

Version Role 
(Configuration) 

AMD Athlon 64 X2  
2.0 GHz 
2 GB RAM 

Microsoft Windows 7  

Internet Explorer 

Professional x64 

9.0 

Workstation 
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New/Modified Functionality 
With GRAMS Envision 2.1, you will be able to search for, thumbnail and preview more data 
formats than ever before, and then investigate them in many more ways. 

Envision 2.1 has the following new features: 

• Windows 7 Explorer enhancements: 

• Full text searching of GAML and SPC format files. 

• Thumbnail icons of each spectrum. 

• Live preview of each spectrum or chromatogram. 

• Enhanced 3D display modes – with axis swapping and multiple surface styles 

• Unit Conversion to allow disparate data to be overlaid on a single trace view. 

• Automatic or manual unit selection for data with arbitrary axes. 

• User-specified conversion for 180+ formats (in addition to Smart Convert). 

• Direct digital links to Thermo Scientific Dionex Chromeleon 6.8 and Waters Empower 3. 

• GAML Convert tool – for bulk conversion of instrument data files. 

• Updated converters – including Agilent ChemStation B. 

More details on some of these new features are given below. For details of specific fixed defects, 
see the Fixed Defects section. 

We also encourage you to open an HTML Viewer inside Envision. It will take you initially to its 
default page, http://gaml.org/envision – here you will find Envision resources, such as “what’s 
new”, overview training videos, and example data files. You can also sign up, from this page, to 
find out more about interesting new applications and developments within the GRAMS Suite. 

 

http://gaml.org/envision


Product Release Notes  GRAMS Envision 2.1  

Revision A  Page 6 of 22 

Windows 7 Explorer Enhancements 
Desktop searching of GAML and SPC files has been integrated into the operating system, allowing 
you to rapidly find files of interest based on their contents – not just their names.  

Once you find the files, you will be able to see the traces they contain as a thumbnail view, and 
then select individual files in the Windows Explorer to access a live preview, complete with zoom 
function.  

 
Windows 7 Explorer showing thumbnail icons, live preview and full text search 

You can do all of this anywhere within Windows – from the Start menu, in Windows Explorer, or 
inside Envision’s File > Open window. Search folders can be created which will be constantly 
updated with, for instance, all SPC files created by a specific user or instrument. 

Note These enhancements also work for Windows Vista. 
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Enhanced 3D Display Modes 
Once you have found and selected the data you wish to view, you are able to invoke more 3D 
viewing capability than ever before – we have added axis switching, new surface styles and 
cursor modes. 

 
GAML 3D Viewer showing Cursor Mode options and Wireframe surface style 
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Unit Conversion and Selection 
In many cases, you may have data from multiple sources that each uses a different scale. In 
order to allow these data to be viewed simultaneously, we have added a unit conversion 
capability to the Trace Viewer. Traces can be converted manually or an automated rule may be 
applied to convert all traces of a specific type (even those undefined “arbitrary” traces) to a 
standardized unit. 

 
Unit Display Configuration window 
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User-Specified Instrument Data File Conversion 
If you know what instrument produced your data, you can import data files using the new File > 
Import (by Instrument Type) option. This allows you to specify an instrument, from the list of 
all installed instrument data file converters, before selecting your data files. 

 
List of instruments when importing a data file 

Note This is in addition to Smart Convert functionality, and can be used if Smart Convert fails to 
successfully identify the instrument used to create a data file. 

Direct Links to Chromeleon and Empower 
We have enhanced our import capabilities to allow data to be pulled from Chromatography 
“database” systems, such as Dionex Chromeleon and Waters Empower.  

When using the new File > Import (by Instrument Type) option to import data, the list of 
instruments you can select includes these database systems, which are appended with 
"[Database]". If you select one of these, an additional dialog box allows you to specify login 
details. 

 
Specifying Chromeleon login details when importing data 

When this capability is coupled to a server with the Thermo Web Access Suite (our multi-user 
remote web access tool), any licensed user can access remote data, via the browser, as rapidly as 
if they were sitting in the data center. 
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Bulk Conversion of Instrument Data Files 
For those with a need to bulk convert instrument data files to a neutral XML format, Envision 
ships with a separately licensed “GAML Convert” tool. This is capable of “walking” through a 
specified directory structure and automatically converting its contents into GAML XML files that 
preserve as much of the instrument metadata as is exposed by the vendor, as well as its trace 
information. 

 
GAML Convert tool 

For information on the platform-neutral GAML format, see http://gaml.org. 

Updated Instrument Data File Converters 
The release also provides updated 64-bit compatible converters for Agilent ChemStation B, ASD, 
Bomem, Digilab, Mattson, PE Nelson, Sadtler, Temet and Waters instruments – see the Converter 
Support table, at the end of this document. 

 

http://gaml.org/
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Fixed Defects 
The following list details the software changes (defects) that have been implemented in this 
product release.  

Pivotal Issue 
Number 

Description 

9929 IR-GAML-0000016: Enhance Envision command line processing. 

The Envision command line processing should be enhanced to provide error 
messages for syntax errors. Currently, invalid command lines are ignored and 
Envision opens with an empty window. 

10788 IR-GAML-0000116: Masslynx PDA trace intensities do not match customer raw 
data. 

20509 IR-GAML-0000105: GAMLIO identifies TraceType incorrectly. 

If a GAML file contains two “TraceArrays” (i.e. XData elements) in one trace, 
the TraceType code can incorrectly identify the type.  If the technique is 
CHROM, the type should be traceXYY. 

20758 IR-GAML-0000103: Peakpro Retention Time error. 

PeakPro injections that have been processed with a system suitability program 
have a different format. This results in the peak labels losing their references 
when imported into Atlas. 

29626 IR-GAML-0000100: Unhandled exception has occurred while saving the Trace 
node of a GAML file. 

When user opens the saved Trace node file with GRAMS Envision, it is 
observed that this file is added as a root node of the file navigator and, if user 
tries to save this file by right click menu of the Root node with same “Name” 
and same “Save as type” (.spc) by replacing the old file, an unhandled 
exception occurs in the application. 

29629 IR-GAML-0000099: Unhandled exception has occurred while saving a GAML 
file. 

When trying to save a GAML file, if user enters the file name with .doc 
extension (e.g. “Adhoc issue.doc”) and clicks [Save], an unhandled exception 
occurs in the application. 

29632 IR-GAML-0000096: Improper behavior is observed while using the <Ctrl+C> 
keys in Envision. 

When the user tries to copy the selected row from the Peak Table viewer 
window using the <Ctrl+C> keyboard shortcut, it is observed that <Ctrl+C> 
triggers the Main menu’s “File > Close” option, which closes the currently open 
file, instead of  the Main Window menu’s “Edit > Copy” option. 
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Pivotal Issue 
Number 

Description 

29634 IR-GAML-0000094: Line Properties “Style” selection is not working properly. 

In Line Properties, if the only the “Style” is changed to something other than 
Solid (i.e. DashDot), it is properly displayed. However if you then change the 
“Width” while keeping the Style something other than Solid, the graph displays 
the default Solid instead of any other style. 

29635 IR-GAML-0000093: An Unhandled Exception is displayed when user tries to 
submit URL as “http://” in HTML Viewer window. 

On opening any GAML file and HTML viewer one after one, if user changes the 
window view from tabbed view to horizontal view and on trying to submit the 
URL address of HTML viewer as “http://”, it is observed that an unhandled 
exception is displayed. 

Note that the issue is also observed when user is in the vertical view of the 
window. 

29720 IR-GAML-0000082: Envision crashes when GAML 3D Viewer is opened if DEP is 
turned on for the application. 

If Data Execution Prevention (DEP) is turned on for all programs on the 
system, Envision will crash if the GAML 3D Viewer is opened. 

30615 IR-GAML-0000080: Envision fails to launch Spectral ID from the “link viewer” 
window. 

The installation path of GRAMS changed with release 9.0. The path was fixed 
in the main Envision windows. However, it was not updated in the code that 
handles the “link viewer”. 

32321 Converting a J-Camp file that contains a line greater than 128 characters long 
causes the converter to crash. 

A customer reported an issue converting a J-Camp file that had an entry in the 
AUDIT TRAIL that was fairly long. This caused the converter to crash. 

33911 The ASD Indico converter has a few issues that make it difficult for the 
customer to use. 

The instrument vendor has requested the following changes to this new 
converter: 

1. It should ONLY process the file three in the ASD file and ignore the other 
two. 

2. The reflectance data should be converted to Log (1/R) and the axis should 
be labeled appropriately. 

3. The technique should be NIR (near infrared). 
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Pivotal Issue 
Number 

Description 

N/A Converting a GAML file that is missing a CollectDate to SPC incorrectly puts a 
date of 1889 in the SPC header. 

When converting a GAML file to SPC, if the collectdate element is missing, the 
resulting SPC has an invalid date. Note that when opening the GAML file in 
Envision, and “sending” the trace to GRAMS, this does not happen. 

N/A Envision license settings are not updated when license is changed in “About” 
box. 

If a user selects “Help > About GRAMS Envision > Select New License” and 
changes the license, the application does not update the current settings. The 
user must exit and restart Envision to apply the new license setting.  

Also, when a licensing error occurs, the underlying FlexNet error is not 
displayed in the error message. This makes it difficult to debug license issues. 

N/A Envision incorrectly opens multiple data files. 

If multiple files are selected when using “File > Open” or “File > Import (by 
Instrument)”, the “GAML-level” nodes are not updated properly. Only the last 
file is displayed.  

Also, if any of the GAML nodes are saved to disk, the contents will be the 
contents of the last file opened. 
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Known Defects 
The following list contains all known issues with a severity level of 4 or 5, as well as issues with a 
severity level of 3 identified within this release. The defects are listed with a severity rating where 
available and a workaround if known. 

A complete listing of known issues and Knowledge Base articles can be obtained in the eService 
Portal by using the following link: http://eservice.thermo.com/. You must have a valid and 
current support contract in order to access this information. 

Pivotal Issue 
Number 

Description Severity 

33850 Index tab missing on the Grams Envision Help screen. 

During a review, it was discovered that many entries are 
missing from the Index, and many of the existing entries are 
incorrect. As a result, the Index tab was turned off, and will 
be restored in a future release once the underlying issues 
have been resolved. 

3–Moderate 

http://eservice.thermo.com/
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Converter Support 
The following list describes the operating system constraints for each of the file converters 
delivered with GRAMS Envision 2.1. 

Converter Name Type Status 

AIA/ANDI Chromatography 32-bit (GAML) Will run on all supported operating systems 

AIA/ANDI FT-IR 32-bit Will run on all supported operating systems 

AIA/ANDI Mass Spectrometry 32-bit Will run on all supported operating systems 

ANDO AQ Optical Spectrum 
Analyzer 

32-bit (GAML) Will run on all supported operating systems 

ASCII X,Y (Constant X Spacing) 32-bit (GAML) Will run on all supported operating systems 

ASCII X,Y (High Precision X) 32-bit (GAML) Will run on all supported operating systems 

ASCII X,Y (Variable X Spacing) 32-bit (GAML) Will run on all supported operating systems 

ASCII Y (Single Column) 32-bit (GAML) Will run on all supported operating systems 

ASD Indico 32-bit (GAML) Will run on all supported operating systems 

ASD PSII UV-Vis 16-bit Will not run on Windows 7 64-bit 

ASYST V1.5+ Data File 16-bit Will not run on Windows 7 64-bit 

AVIV UV-Vis/CD 16-bit Will not run on Windows 7 64-bit 

Acorn NMR NUTS 32-bit Will run on all supported operating systems 

Agilent ChemStation 
(LC/GC/PDA/MS) 

32-bit (GAML) Will run on all supported operating systems 

Alton Instruments LS2000 16-bit Will not run on Windows 7 64-bit 

Amersham Bioscience UNICORN 32-bit (GAML) Will run on all supported operating systems 

Analect FT-IR 32-bit Will run on all supported operating systems 

Ando AQ-6312B 16-bit Will not run on Windows 7 64-bit 

Applied Automation Optichrom 16-bit Will not run on Windows 7 64-bit 

Atlas Chromatography Data 
System 

32-bit (GAML) Will run on all supported operating systems 
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Converter Name Type Status 

Beckman DU60 ASCII UV-Vis 16-bit Will not run on Windows 7 64-bit 

Beckman FT1000/2000 FT-IR 16-bit Will not run on Windows 7 64-bit 

Beckman Gold Chromatography 32-bit (GAML) Will run on all supported operating systems 

Beckman Gold Diode Array 16-bit Will not run on Windows 7 64-bit 

Beckman PeakPro 
Chromatography Data System 

32-bit (GAML) Will run on all supported operating systems 

Beckman UV-Vis/Fluorescence 16-bit Will not run on Windows 7 64-bit 

Bio-Rad BioDimension DAD 16-bit Will not run on Windows 7 64-bit 

Bio-Rad Digilab 3200 FT-IR 32-bit (GAML) Will run on all supported operating systems 

Bio-Rad Digilab IMX FT-IR 32-bit (GAML) Will run on all supported operating systems 

Bio-Rad Sadtler IR 32-bit (GAML) Will run on all supported operating systems 

Bomem DA3/DA8 FT-IR 32-bit (GAML) Will run on all supported operating systems 

Brimrose AOTF NIR 16-bit Will not run on Windows 7 64-bit 

Bruker ATS FT-IR (Aspect) 16-bit Will not run on Windows 7 64-bit 

Bruker AXS DIFFRACplus/AT 
XRD 

32-bit Will run on all supported operating systems 

Bruker Aspect NMR 32-bit Will run on all supported operating systems 

Bruker ESP300 ESR 16-bit Will not run on Windows 7 64-bit 

Bruker OPUS FT-IR (OS/2) 32-bit Will run on all supported operating systems 

Bruker UXNMR (X32) 16-bit Will not run on Windows 7 64-bit 

Bruker WIN-NMR 16-bit Will not run on Windows 7 64-bit 

Bruker XWIN-NMR 32-bit (GAML) Will run on all supported operating systems 

Chemagnetics CMX NMR 16-bit Will not run on Windows 7 64-bit 

Chemagnetics SpinSight NMR 32-bit Will run on all supported operating systems 

Data Interchange Format (DIF) 16-bit Will not run on Windows 7 64-bit 

Dilor Microdil 28 Raman (V2) 16-bit Will not run on Windows 7 64-bit 
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Converter Name Type Status 

Dilor Microdil 28/Z24 Raman 
(V1) 

16-bit Will not run on Windows 7 64-bit 

Dionex Chromeleon 
Chromatography Data System 

32-bit (GAML) Will run on all supported operating systems 

Dionex-Lee Scientific 600 16-bit Will not run on Windows 7 64-bit 

EG&G PAR CCD Spectrum 16-bit Will not run on Windows 7 64-bit 

EG&G PAR OMA88 CCD 
Spectrum 

16-bit Will not run on Windows 7 64-bit 

EG&G PAR ProcessVision 16-bit Will not run on Windows 7 64-bit 

EG&G Spectrum Master Maestro 
II 

16-bit Will not run on Windows 7 64-bit 

EZChrom Elite Chromatography 32-bit (GAML) Will run on all supported operating systems 

Finnigan MAT ITDS GC-MS 16-bit Will not run on Windows 7 64-bit 

GBC Spectral UV-Vis 32-bit Will run on all supported operating systems 

GE Omega NMR 16-bit Will not run on Windows 7 64-bit 

GE/Nicolet NMR (1280) 16-bit Will not run on Windows 7 64-bit 

Gilson Unipoint Chrom.  32-bit Will run on all supported operating systems 

Groton Tech. PF1 DAD 16-bit Will not run on Windows 7 64-bit 

Groton Tech. SoloNet DAD 16-bit Will not run on Windows 7 64-bit 

Guided Wave NIR 16-bit Will not run on Windows 7 64-bit 

HP 1040 Diode Array (PAWS) 16-bit Will not run on Windows 7 64-bit 

HP 1090 Diode Array (PAWS) 32-bit (GAML) Will run on all supported operating systems 

HP 8452 Time Scan (DOS) 16-bit Will not run on Windows 7 64-bit 

HP 8452 UV-Vis (DOS) 16-bit Will not run on Windows 7 64-bit 

HP ChemStation Chromatogram 32-bit (GAML) Will run on all supported operating systems 

HP ChemStation Diode Array 32-bit (GAML) Will run on all supported operating systems 

HP ChemStation IRD GC-IR 16-bit Will not run on Windows 7 64-bit 
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Converter Name Type Status 

HP ChemStation MSD GC-MS 32-bit (GAML) Will run on all supported operating systems 

HP LAS Converter 32-bit (GAML) Will run on all supported operating systems 

Hitachi D-7000 HPLC System 32-bit (GAML) Will run on all supported operating systems 

Hitachi R-1200/1100 NMR 32-bit Will run on all supported operating systems 

Hitachi R-1500 NMR 16-bit Will not run on Windows 7 64-bit 

Horiba FT-IR 16-bit Will not run on Windows 7 64-bit 

IBM 9420/9430 UV-Vis 16-bit Will not run on Windows 7 64-bit 

IBM IR30 FT-IR 16-bit Will not run on Windows 7 64-bit 

ISA PRISM Raman 16-bit Will not run on Windows 7 64-bit 

ISA SPEX Raman 16-bit Will not run on Windows 7 64-bit 

ISA SpectraMax Raman 16-bit Will not run on Windows 7 64-bit 

Interspectrum/Spectrolab 
PFS2000 

32-bit Will run on all supported operating systems 

JCAMP-DX Data File 32-bit (GAML) Will run on all supported operating systems 

Jasco J-600 CD 16-bit Will not run on Windows 7 64-bit 

Jasco J-700 CD 16-bit Will not run on Windows 7 64-bit 

Jasco Spectra Manager 32-bit (GAML) Will run on all supported operating systems 

Jeol GX/EX NMR 32-bit Will run on all supported operating systems 

Jeol Generic NMR 32-bit Will run on all supported operating systems 

Jeol WinSpec FT-IR 32-bit Will run on all supported operating systems 

Kontron DS-450 Chromatogram 16-bit Will not run on Windows 7 64-bit 

Kratos MACH3 GC-MS 16-bit Will not run on Windows 7 64-bit 

LDC Analytical SM5000 DAD 16-bit Will not run on Windows 7 64-bit 

LTI SpectraMetrix/PowerScan 16-bit Will not run on Windows 7 64-bit 

LabControl SPECTACLE File 32-bit Will run on all supported operating systems 

LeCroy 7200 Oscilloscope 16-bit Will not run on Windows 7 64-bit 
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Converter Name Type Status 

LeCroy 8818A Digitizer/Catalyst 16-bit Will not run on Windows 7 64-bit 

LeCroy 94xx Oscilloscopes 16-bit Will not run on Windows 7 64-bit 

Linear Instruments DAD 16-bit Will not run on Windows 7 64-bit 

Lotus 123 Worksheet (V1.0a) 16-bit Will not run on Windows 7 64-bit 

Lotus 123 Worksheet (V2.0) 16-bit Will not run on Windows 7 64-bit 

Mattson FIRST/WinFIRST FT-IR 16-bit Will not run on Windows 7 64-bit 

Mattson ICON FT-IR 32-bit (GAML) Will run on all supported operating systems 

Micromass MassLynx 
Chromatography Data System 

32-bit (GAML) Will run on all supported operating systems 

NIRSystems NSAS/Vision 32-bit Will run on all supported operating systems 

NIST MSP Text 32-bit Will run on all supported operating systems 

Nicolet PCIR FT-IR 16-bit Will not run on Windows 7 64-bit 

Nicolet SX/DX FT-IR (1280) 16-bit Will not run on Windows 7 64-bit 

Oriel DOS InstaSpec 16-bit Will not run on Windows 7 64-bit 

Oriel Runes II 16-bit Will not run on Windows 7 64-bit 

Otsuka Diode Array 16-bit Will not run on Windows 7 64-bit 

PE Nelson 2600 Chromatogram 32-bit (GAML) Will run on all supported operating systems 

PE Nelson Access*Chrom 32-bit (GAML) Will run on all supported operating systems 

PE Nelson TurboChrom (V3.3) 16-bit Will not run on Windows 7 64-bit 

PE Sciex Analyst (WinNT LC-MS) 32-bit (GAML) Will run on all supported operating systems 

Perkin Elmer PIONIR 16-bit Will not run on Windows 7 64-bit 

Perkin Elmer TurboChrom 32-bit (GAML) Will run on all upported operating systems. 

Perkin-Elmer 7000 FT-IR & UV-
Vis 

16-bit Will not run on Windows 7 64-bit 

Perkin-Elmer IR Data Manager 16-bit Will not run on Windows 7 64-bit 

Perkin-Elmer PC137 SAM 16-bit Will not run on Windows 7 64-bit 
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Converter Name Type Status 

Perkin-Elmer Spectrum/Winlab 32-bit (GAML) Will run on all supported operating systems 

Perkin-Elmer TurboMass LC/GC-
MS 

32-bit Will run on all supported operating systems 

Perkin-Elmer UV/FL Data 
Manager (B) 

16-bit Will not run on Windows 7 64-bit 

Perkin-Elmer UV/FL Data 
Manager 

16-bit Will not run on Windows 7 64-bit 

Perten Instruments PerCon NIR 32-bit Will run on all supported operating systems 

Pharmacia LKB Gelscan XL 16-bit Will not run on Windows 7 64-bit 

Phillips IR/40 FT-IR 16-bit Will not run on Windows 7 64-bit 

Polymer Laboratories Cirrus 
GPC/Triple Detection Converter 

32-bit (GAML) Will run on all supported operating systems 

Princeton Instruments CCD 16-bit Will not run on Windows 7 64-bit 

Radiomatic FLO-One ASCII File 16-bit Will not run on Windows 7 64-bit 

SLM Aminco 3000 UV-Vis 16-bit Will not run on Windows 7 64-bit 

SLM Aminco Universal File 16-bit Will not run on Windows 7 64-bit 

Shimadzu HyperIR FT-IR 32-bit Will run on all supported operating systems 

Shimadzu QP5000 GC-MS 16-bit Will not run on Windows 7 64-bit 

Shimadzu UV160/265 16-bit Will not run on Windows 7 64-bit 

Siemens AXS DIFFRACplus/AT 
XRD 

32-bit Will run on all supported operating systems 

Spectra Physics ChromStation 16-bit Will not run on Windows 7 64-bit 

Spectra Physics DAD 16-bit Will not run on Windows 7 64-bit 

Spectra Physics Memory Module 16-bit Will not run on Windows 7 64-bit 

Spectronic SLM-Aminco Bowman 
2 

32-bit (GAML) Will run on all supported operating systems. 

Stanford Research SR265 16-bit Will not run on Windows 7 64-bit 

TA Instruments Universal 
Analysis (DSC & TGA only) 

32-bit Will run on all supported operating systems 
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Converter Name Type Status 

Target Chromatography Analysis 
Software 

32-bit (GAML) Will run on all supported operating systems 

TechMag MacNMR 16-bit Will not run on Windows 7 64-bit 

Teknivent GC-MS 16-bit Will not run on Windows 7 64-bit 

Telos Labs Spectrogram FT-IR 16-bit Will not run on Windows 7 64-bit 

Temet Instruments FT-IR 32-bit (GAML) Will run on all supported operating systems 

Thermo Elemental Solaar 
Converter 

32-bit (GAML) Will run on all supported operating systems 

Thermo Finnigan Xcalibur 
Converter 

32-bit (GAML) Will run on all supported operating systems 

Thermo Fisher ASCII File with 
Header 

32-bit (GAML) Will run on all supported operating systems 

Thermo Fisher GAML 32-bit (GAML) Will run on all supported operating systems 

Thermo Fisher IEEE 32-bit Float 
File 

16-bit Will not run on Windows 7 64-bit 

Thermo Fisher SPC 32-bit (GAML) Will run on all supported operating systems 

Thermo LabSystems Multichrom 32-bit (GAML) Will run on all supported operating systems 

Thermo Nicolet Omnic 32-bit (GAML) Will run on all supported operating systems 

Thermo Spectronic Helios 32-bit (GAML) Will run on all supported operating systems 

Tracor Northern TN-6500 16-bit Will not run on Windows 7 64-bit 

Tracor Northern TN-6600 16-bit Will not run on Windows 7 64-bit 

VG Plasma-Quad ICP-MS 16-bit Will not run on Windows 7 64-bit 

Varian Cary UV-VIS-NIR 32-bit (GAML) Will run on all supported operating systems 

Varian Cary UV-Vis (OS/2) 16-bit Will not run on Windows 7 64-bit 

Varian Chemagnetics NMR 32-bit Will run on all supported operating systems 

Varian Galaxie /JMBS 
DIAMIR/Bio-Tek KromaSystem 
3000 

32-bit (GAML) Will run on all supported operating systems 

Varian Saturn 3 GC-MS 16-bit Will not run on Windows 7 64-bit 
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Converter Name Type Status 

Varian Saturn 5 GC-MS 32-bit Will run on all supported operating systems 

Varian Star GC 32-bit Will run on all supported operating systems 

Varian VNMR 32-bit Will run on all supported operating systems 

Varian XL/XR/Gemini NMR 16-bit Will not run on Windows 7 64-bit 

Waters 990 DAD 16-bit Will not run on Windows 7 64-bit 

Waters Maxima 820 
Chromatogram 

32-bit (GAML) Will run on all supported operating systems 

Zeiss ASCII File 16-bit Will not run on Windows 7 64-bit 
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